Official guide

FIRST STEPS
with Pandora FMS
Official start-up guide to get the most
out of Pandora FMS, from installation to
report generation. If you don’t want to
mess with the manual, this is your guide.
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Introduction
The purpose of this guide is to briefly introduce Pandora FMS to someone who is
not familiar with the tool. The purpose is not to make a tour through all Pandora
FMS features, but to talk about the most relevant ones in order to start working
and managing in record time.
Pandora FMS architecture is made up of different services:

•
•
•

Database server (Percona/MySQL)
Web console.
Pandora FMS server (which runs different types of services).

A small optional application (software agent) that runs on the servers you want to
collect information from (both windows and linux) and send it to the central server.
pandorafms.com

We call agent to any network device that can be monitored. That is to say, everything
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you can obtain data from and that has an associated IP, such as servers, routers or
switches. The number of these agents is what is used to license a Pandora FMS
Enterprise installation, for example, a 100 agent license.
The information collected in each agent is not relevant, it does not matter if it is a
router with just a few simple metrics or a 48-port switch full of information. These
metrics in Pandora FMS are known as modules. A software agent is the piece of
software that collects information, an agent, simply, is how this information is
displayed and managed. They only share the name.

Minimum hardware requirements
The requirements set out in this table are the minimum recommended for the
different installations. These recommendations are calculated assuming that 80%
of the modules have historical data, that each agent has an average of about 10
modules and that the average sampling is five minutes.
These recommendations are specified for an environment where they are installed
in the same database server, server and console.

INTRODUCCIÓN

Hardware

Small

Medium

Big

CPU

2 cores at 2 GHz

2 cores at 2,5 GHz

4 cores at 3 GHz

RAM

4 GB

8 GB

16 GB

HD

7200 rpm

15K RPM or SSD

SSD

Storage

~20GB

~60GB

~120GB

Up to 500 agentes

Up to 2000
agentes

5000 agentes

Capacity

In addition to the above recommendations, it is recommended that you
install MySQL on a separate server and install Percona XTraDB instead of
the standard MySQL.

If you already have a Pandora FMS installation, go straight to device discovery
Everything discovered and configured? Go to metric alerting
You need to start seeing you data, start with reports
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•
•
•
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Installation

Pandora FMS ISO Appliance will be used, since it is the fastest and easiest method.
For more information on alternative installation methods, check Pandora FMS
Installation from our official documentation.

Pandora FMS uses Linux as a base, but Pandora FMS is designed so that. As an
administrator user, you do not have to know about Linux or interact with it.
99% of the configuration and operation is done from Pandora FMS
graphic console and it is not necessary to access the shell (the command
black screen) of Linux system.
The installation image is based on Linux CentOS 7, and contains all the components
and dependencies needed for Pandora FMS to work pre-installed. You must have
a machine with minimum hardware requirements, a minimum of 4GB of RAM and
pandorafms.com

20GB of disk.
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If you are pondering over Pandora FMS Enterprise version, the license
comes pre-installed, and once it is activated and running, you will have 30
days to try the product.
After this time, your Pandora FMS will automatically become the Community
version and you will be able to continue using it indefinitely. No data is lost and the
system will continue working, but without Enterprise version features.

Installation from ISO Appliance
The ISO image must be downloaded from the download section and burned
to a DVD, or you can also boot the system from this ISO file if you are using a
virtualization system (VMWare, VirtualBox, etc).
The graphical installer will guide you step by step through the whole installation
process. This installer is available in several languages and follows a standard
installation process. The two sections where you should pay special attention
are when asking for the root password and when asking about partitioning.
Once installed, you will not have to access the Linux base system again.
You can also do a manual network configuration at this point. Otherwise, the
system will try to activate the network interface and assign an IP through DHCP.

I N S TA L L AT I O N F R O M I S O A P P L I A N C E

The requested options, “Date and Time”, “Keyboard” and “Installation Destination”

pandorafms.com

must be selected and configured. The network device must be activated.
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The network interface is activated and the hostname can optionally be changed.
If you are going to set a fixed IP, this is the time to configure it, otherwise
you will get it by DHCP.

I N S TA L L AT I O N F R O M I S O A P P L I A N C E

pandorafms.com

Clicking on the installation destination will start disk partitioning.
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I N S TA L L AT I O N F R O M I S O A P P L I A N C E

Select the disk where you are going to install and the partitioning is chosen. The

pandorafms.com

“Click to create them automatically” option will be used.
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The created partitions will be checked and click Done. Click Accept changes.

Click on Start installation, at the bottom and the process will start installing.
Do not forget the root password or you will have to reinstall everything

I N S TA L L AT I O N F R O M I S O A P P L I A N C E

Now wait until the installation is complete and the system is rebooted. If you are
using virtualization, make sure the system boots from the disk first, or unmount the
CD drive with Pandora FMS installation image. If you install from USB or CD, when
the system will restart.

First steps
Once installed, the system should boot from the hard disk and after a few seconds,
display a terminal screen:

In this same screen you should find the IP that the system has assigned to be able
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Once you know the IP of Pandora FMS system, you can access it from a browser.
Write in it the following address, composed by the IP obtained:
http://x.x.x.x/pandora_console

In the example above it would be http://192.168.126.129/pandora_console, but you
have to get the system IP correctly in order to continue. If everything is correct,
you will access Pandora FMS console welcome screen, similar to this one:

END OF CHAPTER

pandorafms.com

to connect to Pandora FMS console.
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Detecting and monitoring new systems
with Discovery
Pandora FMS Discovery tool provides a set of tools to simplify monitoring through
wizards, including Discovery’s Network Scan feature.
To use it, follow these steps. In the side menu go to “Discovery -> Host&Devices ->

pandorafms.com

Network Scan” section.
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Create the task as follows: modify only the network range to be scanned, in
this screenshot it is 192.168.70.0/24, which means that all hosts on the network
192.168.70.xx will be scanned. Select the “Unknown” group, which will be used to
contain the devices you detect in that group. From now on we will overall call
“agents” the devices managed and/or monitored by Pandora FMS.

DETECTING AND MONITORING NEW SYSTEMS WITH DISCOVERY

You may select different aspects of the initial monitoring that will be applied to the
discovered devices. You may define different pre-configured templates, as you can
see in the image. Choose the option “BASIC MONITORING” and leave unchecked

pandorafms.com

the option “Review results”.
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Once the recognition task is created, as it has been created with manual interval,
start it manually. For that, force its execution in the discovery task list:

DETECTING AND MONITORING NEW SYSTEMS WITH DISCOVERY

Its progress will be updated:

pandorafms.com

At any time, you may click on the magnifying glass icon to see the task details:
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At this point it is better to wait until the entire network has been detected. When
it is finished, go to the agent detail view to see all the detected systems. Menu
“Monitoring” > “Views” > “ “Agent detail”, as seen in the image:

DETECTING AND MONITORING NEW SYSTEMS WITH DISCOVERY

You will see several systems that have been detected. In some cases, the name
of the system will have been resolved (if it was possible by DNS) and in others
the type of Operating System will have been detected, according to the options
selected in the network scan carried out with Discovery.
Clicking on the name will lead you to agent detail view, which will show all the
system information. In this case, the agent has only one module, the “Host alive”
module, a check that verifies that the machine is “alive” and responds from the

pandorafms.com

network:

alert chapter

END OF CHAPTER
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If you do not need more monitoring or configuration, go to the metric
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Detecting and monitoring network and
Windows devices with Discovery
Let us now look at a more complex discovery task by configuring SNMP and
WMI, two protocols used to remotely monitor devices, both network (SNMP) and
Windows (WMI).
The configuration process is similar to the previous one, but here got to the

pandorafms.com

discovery task configuration options and look at the bottom.
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To enable monitoring with SNMP and WMI, activate the corresponding token and
provide the data required by each protocol. SNMP has “communities” that are like
access passwords. If you do not know your SNMP community, try “public”. You can
enter as many as you want, so that it will be tested with all of them.
The credentials for the WMI service (and others) can be defined in Profiles ->
Manage agent groups -> Credential Store.
Credential stores are secure user/password stores that are used later in
remote checks, device configurations, remote access, etc. So they can
be reused at different points in Pandora FMS.

DETECTING AND MONITORING NETWORK AND WINDOWS DEVICES WITH DISCOVERY

Also enable the “Review results” token, which will allow you to see the components
found by Pandora FMS in the discovery task once it is finished, showing what it has
found and allowing to add it to the remote monitoring of the agent with just one

PAG
14

If you do not need more monitoring or configuration, go to the metric
alert chapter

END OF CHAPTER
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click.
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Network device monitoring through
SNMP Interface Wizard
In order to perform this type of monitoring, it is essential for the SNMP to be
configured in the remote device. This usually needs to be activated as well as a
minimum configuration that allows us to check data. SNMP devices allow you to
configure which IPs can make queries and with which ‘’community’’, which for all
intents and purposes is a kind of password.
Most network devices (routers, switches) have the community “public”
by default.
First locate the agent from where you want to get the network traffic; in this case
we are going to use a CISCO Catalyst switch, but it could be any device with SNMP
enabled. Following the same process ‘’Monitoring” > “Views” > “Agent detail’’ you
will reach the main view of the agent you want to configure and click on the last

pandorafms.com

tab on the right, which will take you to the editing view of that agent.
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Go to the main view of the agent editing. Here you will see the agent configuration
“Wizards” submenu, where to choose the SNMP Interface Wizard, as you can see
in the following screenshot:

NET WORK DEVICE MONITORING THROUGH SNMP INTERFACE WIZARD

The SNMP wizard will allow to track the agent’s interfaces. Provide “SNMP
community” and “version” data. If everything works, it will show the interfaces and

pandorafms.com

the data that can be obtained from them.
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With a simple click you will be able to select the metrics you are interested in
from all the switch interfaces and even define thresholds with warning and critical
values that will later be useful to work with the alerts.
Click on “Create modules” and a screen should inform that the modules have been
created.
The network traffic modules are ‘’incremental’’, that means that its value
is the difference between the information sample that has just been
collected and the previous one. It shows a ‘’rate’’ (in this case in bytes/
sec), so it needs time (about 1 or 2 agent intervals) before showing
anything.
Click on the “View” tab to return to the agent view and wait for a minimum of 1
agent interval until you already have data, updating or clicking on the “View” tab.
If you do not want to wait any more or you want to “force” the execution of all
the remote agent modules, use the “force remote check” icon. Depending on the
server load, it can take between 2 and 15 seconds to execute the test:

NET WORK DEVICE MONITORING THROUGH SNMP INTERFACE WIZARD

Module information will be seen this way and the graphs for each metric will show
a window with the graph of that monitor and when clicking on the data icon, a

pandorafms.com

table with the data:
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Let us see a graph of one of the individual metrics (Gi0/5_ifInOctets):

You may also use the “Interfaces” view to easily see the information of the input/
output traffic of each interface. To do this, open the “Interface information (SNMP)”
box under the agent overview:

NET WORK DEVICE MONITORING THROUGH SNMP INTERFACE WIZARD
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By clicking on the graphical icon of an interface
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Network device remote monitoring
Monitoring through network modules.
TCP Service.
In this case, monitoring to verify that an SMTP (mail) service is active on a machine
will be added. Although this could be a very complex check (simulating that user
credentials and passwords are sent, that an email is sent, etc.) it will be simplified
by only checking that the port is open and responsive.
To do that, repeat the same steps from the previous chapter, but this time choose

pandorafms.com

a “Network module”.
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Then use the drop-down controls until you find the desired check (Check SMTP
Server) and click on it to create the module:

NETWORK DEVICE REMOTE MONITORING

Finally, repeat the steps (go to the operation view and refresh until the monitor
appears). Until a module has no data, it will be BLUE, which indicates that it is not
yet initialized:

After a few seconds it should start and take a value, GREEN if the SMTP server
responds, or RED if it does not:

Monitoring through server plugins. Network
packet loss.
We are going to monitor the network packet loss using a remote check that comes
pre-configured in Pandora FMS. For that go to the configuration view of any

pandorafms.com

agent connected to your network, because we are going to measure the packet
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loss from Pandora FMS to the IP of that agent.

The configuration view can be accessed through the cogwheel icon
From there go to the module view:
And create a “Plugin” module:

Choose group of components “Network management” and look for “Packet loss”:

NETWORK DEVICE REMOTE MONITORING

So the new module should look like this:

If the IP is empty, it will use the agent’s IP. We have chosen a “library” module that
uploads some values automatically. Click on “Create” and return to the operation

pandorafms.com

view (eye icon):
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The screen is updated a couple of times, until the new module appears in the list:

The round icon is to “force” the check again (it only works with remote checks):
The graph and data table icon respectively help show an interactive graph or a
table with the data collected by that module. All the modules with active history
have the possibility to see graphs or data:

NETWORK DEVICE REMOTE MONITORING
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(ping) and latency time determines your network quality, as it indicates packet loss
percentage.

END OF CHAPTER
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This is a very interesting plugin, which used together with basic connectivity
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Web Monitoring
For this last example we will use the Pandora FMS web server component that
performs HTTP and HTTPS basic monitoring. This element allows to make simple
or more complex web checks (in several cases), using low level calls. It is useful to
see whether your pages are still alive, verify that you can take a series of steps (for
example, filling in forms) and/or that they contain a certain word. Besides verifying
that they work, you can measure the total time they take.
To create this type of module, choose a webserver type module for module

pandorafms.com

creation.
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Once you click Create, you will see a form where to fill in the necessary fields to
be able to monitor a website. The most important thing will be to choose the type
of check. Here we are going to create a module that will allow to check the loading
time of a web that must contain the word
To do this, select the Remote HTTP module to check latency, which will allow to
see the number of seconds it takes for the server to respond.

The code that you have to add to the web checks’ box is intuitive, in this case we
will make only one request and we will check that the response returns a sentence:
task_begin
get https://pandorafms.com/es/precios-de-pandora-fms
check_string Licencia basada en dispositivos
task_end

WEB MONITORING

The checkup will be as follows:

As always, after a few seconds, you will have already received some data from this
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Pandora FMS also offers the possibility of monitoring complex web
transactions thanks to the User Web Experience which is a more
advanced feature than this one.

END OF CHAPTER
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module, in this case, the seconds it takes for the request to be completed:
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Remote Server Monitoring
Pandora FMS also offers the possibility of monitoring Linux and Windows servers
remotely without installing a software agent.
To achieve this, create remote execution modules that allow you to ask the device
from your Pandora FMS installation by executing a command (Windows or Linux)
remotely and obtaining the result. Create a network module:

Then choose a “Remote execution” module. Choose between the following
ones depending on the type of data that the check returns (numeric, true/false,

pandorafms.com

alphanumeric or incremental):
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To be able to use successfully these modules you need to have remote connection
data to the system you wish to monitor. Therefore, register in the safe credential
store the connection data against the target.
The credential store stores user/password sets so that they can be reused
in different checks and whose data are not shown in check configuration.
To create an entry in the credential store go to section “Profiles -> Manage agent
groups”:

Click on the left tab “Credential store”:

REMOTE SERVER MONITORING

Create a “Custom” credential and set the password and login credentials for your
Windows server:
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You will need to fill in three key fields:

•

The set of credentials that you are going to use to connect (that you defined
in the previous step).

•
•

Optionally the IP of the target (if not, the agent’s IP will be used).
The command that you are going to launch to monitor.

In Windows environments choose “Windows remote” connection:

The example above will indicate the number of processes running on the remote
machine. To perform the same on Linux servers, just choose the remote SSH
connection method, choose port 22 and use a command that returns a number in
Linux. The previous example in Linux would be:

If you want to monitor something that returns a true/false status, such
as the status of a process, just make sure your command returns 0 for
the wrong value and 1 or more for the right value. You should use a
BOOLEAN data type (e.g.: “Remote execution, boolean data”) so that
Pandora FMS interprets it as such.

END OF CHAPTER
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Go back to the remote check and configure this:
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Server Monitoring through Software
Agents
Windows
The first step is to download the Windows agent. You may download it from:
https://pandorafms.com/community/get-started/

In this link you may choose either the 32-bit or 64-bit agent. Once the agent is
downloaded, execute it by double-clicking on it and the usual installation screen

pandorafms.com

will appear. Accept all the steps:
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Accept the license and go through the different installer steps.

Configure in this screen the IP address (or name) of the Pandora FMS server that
will receive the agent’s data and the group we wish for the agent to be associated
with. This group must exist in Pandora FMS.

SERVER MONITORING THROUGH SOF T WARE AGENTS

In the next window there is the option to enable remote configuration. It is
important to activate it by clicking on the checkbox if you wish to remotely manage
the agent’s setup and not have to edit files manually.
The remote configuration management feature is exclusive to Pandora

pandorafms.com

FMS Enterprise version
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Decide if you wish to start the agent service at the end of the installation of Pandora
FMS agent, otherwise it will have to be done manually, or it will be started when
Windows is restarted again.

SERVER MONITORING THROUGH SOF T WARE AGENTS

Once this process is finished, the Windows agent stays installed and running on
the computer. In a few seconds you should be able to see the agent reporting in
your Pandora FMS console.
If you do not see the agent in the console, check that there is a connection
between the agent and the IP of the server you have configured in the
agent. The communication from agent to server uses port 41121/TCP.
Once the Windows agent is started after its installation, it is time to check what
the agent is reporting. To that end you have to know the name this agent is going
to report with. By default, the agent is created with the name of the computer, as

pandorafms.com

you can see in “System information” (in this case DESKTOP-JU0S2L5).
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Once you know the name of the agent, the next step is to see if it has been created
in Pandora FMS. For that there are several options. The first one is to search in agent
details, inside the group where the agent has been created, in the example the
group “Servers” (in this screenshot the name of the computer is laptop-lovobftq).

A faster and more efficient way to find the agent is by searching directly through
Pandora FMS search engine, a the top bar, where you may enter the name of your
machine or a part of it.

SERVER MONITORING THROUGH SOF T WARE AGENTS

Here the agent will appear and by clicking on the name go to the information of
what it reports.

The Windows agent comes with several preloaded local modules for basic
monitoring by default, such as CPU Load, % of free RAM memory (FreeMemory),

pandorafms.com

free space in disk MB, DHCP status (DHCP Enabled) and process number.
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If you need to add new modules to this agent, check the advanced documentation
on monitoring through software agents.
You may see graphs generated with the module data history and a table with the
module history from this view by clicking on the icons highlighted in the following
screenshot:

It is important to note that on the same agent, remote monitoring and
agent-based monitoring can be performed, combining them both,
resulting in a much more comprehensive monitoring.

SERVER MONITORING THROUGH SOF T WARE AGENTS

Linux
Monitoring a Linux server is just as simple, but it must be done from the console.
If you are interested, you may download the package corresponding to your linux
distribution (or the self-installable tarball). The configuration needed to set up the
Linux agent, can be found in the file:
/etc/pandora/pandora_agent.conf

Once configured, start the service, e.g:
/etc/init.d/pandora_agent start

In Windows, there is a file with the same name in the directory where Pandora
FMS agent was installed, and you can edit it with a standard text editor. The
configuration tokens are exactly the same both for the Linux agent and for the
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Windows agent, except for some specific Windows agent tokens.
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Module Advanced Settings
In this section we will see how to configure some module advanced options, as well
as to define the measurement thresholds that make a module go into WARNING
or CRITICAL state. In a module’s editing, it is possible to define, additionally, many
other configurations that allow to customized each metric monitored by Pandora
FMS.
Go to the agent modules view, in the agent configuration mode view:
From the normal agent view:

pandorafms.com

Click on the cogwheel icon to go to the agent’s “configuration” mode, and from
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there, click on the monitor icon:

M O D U L E A DVA N C E D S E T T I N G S

In this view, you will find the fields needed to adjust warning and critical
thresholds. In this example, we edit the “CPU Load” module, a module that returns
a numeric value (as you can see in the module type information, it is a “generic
numeric”). Other interesting fields could be the checkbox to disable the module,
or the module group definition combo it is attached to, that is used to “organize” the
modules of an agent so they are grouped. Finally the “Historical data” checkbox
allows to define that this module keeps all the information it receives (to show

pandorafms.com

historical graphs) or only the last value collected.
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You will also see some other interesting fields at the bottom of the Advanced
Options drop-down tab:

Thresholds
In this section, configure the “Warning” and “Critical” thresholds for a module,
that define which values a module must have to be in CRITICAL, WARNING or
NORMAL status. Let’s see an example:

M O D U L E A DVA N C E D S E T T I N G S

In our example there is a “CPU %” module to add thresholds to. This module, by
default, will always be in NORMAL state (green) as long as it is between 0% and
100%.

pandorafms.com

If you want that module to g into “Critical” or “Warning” status when the CPU
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reaches a certain %, you should configure it setting the desired “Warning Status”
and “Critical Status” thresholds. In this example, we will configure them so that
when the CPU reaches a 60% usage, the module will go into “Warning” status and
if it exceeds 80%, it will go into “Critical”.

After configuring the thresholds, click on “Update” and the thresholds will be
properly configured. The next data received will already interpret those thresholds.

M O D U L E A DVA N C E D S E T T I N G S

Units
This field within advanced options allows to define the units of the data obtained in
a module. This unit will be included in graphs and reports, so it is easier to interpret
the data displayed to the user.
In this example, we want it to have “entries” as unit. We go inside the “Unit” field

pandorafms.com

and choose the desired option from the drop down menu.

the module view.
If the unit does not appear among the available ones, define one by
clicking on the pencil icon.

END OF CHAPTER
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Finally, we click on the “Update” and check that the unit is correctly displayed in
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Email Alert

In Pandora FMS, alerts are assigned to specific agent modules. There are more
advanced tasks (alerts on events, correlation, etc.) but those are not included in
this guide. The first alert is just sending an email when one of the machines that
are already being monitored (from the previous step) is down.
Pandora FMS alerts are made up by three elements: Command (send an email),
Action (send an email to a specific user, using the previous command) and Template
(execute a specific action when a certain term is met).
In this specific case, we are going to use a predefined command (send emails),
we are going to modify an existing action (Mail to XXX) to send it to an specific
email and we are going to use an already existing template, the template ‘’Critical
condition’’, which will execute the alert when the module goes into critical. With
pandorafms.com

the alerts you may do many more things, such as creating a scaling, creating your
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own commands (to make more complex integrations or notifications), sending
recovery warnings, setting correlations and mass assigning alerts, but that is for
another type of guide.

Configuring email alerts
Pandora FMS already contains in its installation a server to send emails whose
default sender is pandora@pandorafms.org. Although generally these are classified
as SPAM by any receiver. In case you want to change the email address in charge
of sending notifications, and the server that processes them, go to the console,
to the section Setup > Setup > General Setup. At the bottom of the configuration
page you will find the Mail configuration section.

EMAIL ALERT

If you use the local server (127.0.0.1) you may not be able to send emails correctly,
as the configuration of your environment will depend on it. If you need more
information, click here.
To prevent emails from being classified as spam, we recommend that you
use a corporate email (exchange, gmail, etc).
To be able to configure the recipient of an alert, modify the action. The action
is “Mail to XXX” in Alerts > Actions. Click on the name of the action to add the
configuration. Follow the menu “Alerts -> Actions”.

pandorafms.com

Edit “Mail to” action and use this example as a reference:
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Field 1 (Destination address) will be modified and the destination email address
must be added.

EMAIL ALERT

In field 2 enter the text from the screenshot. Here two macros are used (_agent_
and _module_) and they will replace at run time the agent name and the module
generated by the alert.
There are about forty macros that you can use to obtain values at the time
of executing alerts. Read the documentation.
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Field 3 could be used to shape the email, in HTML or plain text:
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Although Pandora FMS includes an HTML viewer, we recommend that if you are
going to write emails in HTML, copy and paste the code here:

If you have not changed the default action, the HTML template of the mail will be
similar to this one. You can modify it later, now let us see how alerts are assigned.

EMAIL ALERT

Assigning an alert to a module
Go to the agent edition view where you wish to assign an alert to an already defined
module and click on the alert tab:

Now add the module (for example, Host Alive), the template (Critical Condition)
and the action that you configured in the previous step (Mail to XXX). Add the alert:
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not, seeing the color of its state:

You may wait (or force) the host to fail to see if the alert works, or you may “force
the alert” to see if the mail is actually sent. Click on the force icon (see image):

An email with the alert should be sent to the mailbox. As it is a “forced” alert, in the
data field it says N/A. In real fife it would show the real module value, like this one:

END OF CHAPTER
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Once added, you may see it in the agent view, checking whether it is executed or
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Create a Custom Report
Pandora FMS offers the possibility of custom display for the monitored data
through reports that can be programmed to be sent, exported to PDF or displayed
in real time.
To create a custom report, go to the menu “Reporting” -> “Custom reports”, where

pandorafms.com

you may find the button “Create report” for creating reports.
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First define a name, group, write access or whether the report will be interactive
or not.
Non-interactive reports are reports that due to their large size are
preferable to only be programmed since it takes some time to generate
them.
Once you have filled in these data with the desired requirements, the upper
left menu will offer new options, thanks to which we can start adding different
monitoring items.

You may see that, in addition to the element editor, there are three wizards that will
help you with report creation.

C R E AT E A C U S TO M R E P O R T

The general wizard allows you, for example, to add graphs of different agents/
modules to the report:

The wizard allows to easily create other elements within the report, such as
showing maximum, minimum or average module values in a time interval, a
list of triggered alerts or generated events.
SLA Wizard: This wizard allows to create SLA report items automatically. You
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will be able to choose the value validity ranges of the modules to be selected.
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This feature will allow you to check the time percentage that a module has kept
values within specific ranges. If no thresholds are defined, they will be dynamically
adjusted to the each module’s criticality thresholds. You will be able to know, in
short, what time percentage it behaved as expected.

Grouped reports are also available:

•

Global: In this report section, you may create Exception, General or Top N
elements easily through a wizard.

•

Exception: This shows module values that meet a logical operation (e.g.: show
the occupation percentage of those links that have an activity higher than
100KB/Sec).

•

General: It shows values of several modules ordered (ascending, descending,
by agent name) and/or grouped by name.

•

Top N: It shows N values classified by maximum, minimum or average over the
total of added modules, in ascending or descending order or by agent name.

C R E AT E A C U S TO M R E P O R T

That way you may add different modules from different agents, being also possible
to choose the operation to perform on each module: sum, average, minimum,
maximum. In the tab “Item Editor” you may find more specific elements, such as
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the possibility of creating inventory elements for your reports.
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That will allow you to see the hardware and software data of the agents you select,
if they have inventory values collected. Once the reports have been configured,
you may see them thanks to the “View report” icon at the upper left corner.
In the case of this report, these are the results.
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C R E AT E A C U S TO M R E P O R T
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Visual Console Creation
Parent visual console creation
In this first map we are going to add the status of several agents distributed in a
world map. It can be done manually, one by one or through the Wizard. To make its
creation easier, we are going to use the Wizard in the example.
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The first step is creating a new map, in this example called World Map.
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Once created, click on the Elements Wizard:

V I S UA L C O N S O L E C R E AT I O N

In the Wizard select the element type (in this example Static Graph) the image you
want to use, whether you want to use an item by agent or by module (in this case
by agent), and select the agents you are going to add inside the list that appears.

Click add and all the elements created will appear on the map, as seen in the
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following screenshot.
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Move all the elements to their appropriate map positions, by clicking and dragging
them over it.

V I S UA L C O N S O L E C R E AT I O N

Child visual console creation
In the second map, an element that indicates the state of one of the main agents
will be created, together with all the given modules. You will also see in this map a
graph of the FreeRAM module from the same agent. The first step is to create the
new map like before:

Once created, add the element that shows the state of the agent in the Static
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Graph section, as in the attached image:
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Create the graph with the attached configuration, clicking on the graph icon,
adding the agent and module that you are going to see represented in the graph.
The main element of the map is created. Now create a new element for each of
the agent modules. For that, use the Wizard configuring it as seen in the attached
screenshot. Select the agent Static Graph and the modules you indicate. Set as
label the module name and assign to this item a parent previously created in the
Visual Map, in this case the previous element that you added.
After creating all these elements, they will appear together with the main element
and you may move them dragging them directly with the mouse to the position
you wish.

V I S UA L C O N S O L E C R E AT I O N

Map linking
In the previous steps we created the two maps. In this step we will indicate how
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map “Spain Map”.
To do that, open the World Map in edit mode by double-clicking on the element
192.168.70.70. This will allow to edit the element, click on advanced options and in
the option Linked Map, select Spain Map. Update the element.

When you return to the World Map view, click on the item above Spain and the
map of Spain will open directly. If there is only one element in red on the map of
Spain, the icon representing Spain on the parent map will also be displayed in red.

END OF CHAPTER
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to click on the element located on Spain in the “World Map”, opening directly the
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Dashboard creation
A Dashboard is a Pandora FMS feature that allows each user to build his own
monitoring page. You can add more than one page, and there you can add
monitoring maps, graphs and status summaries, short event lists (with filters) and
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many other widgets.
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To create your own dashboards go to “Reporting” -> “Dashboards”, where you can
select the “New dashboard” button to create the ones you need.
Pandora FMS will show you a new window where you may give name to your new
dashboard and define if it will be a private dashboard, the monitoring group it
belongs to or if you want to define it as a favorite so that it shows up in the lateral
drop-down menu in the dashboards section.

Once these steps are defined configure your first widget.

DA S H B OA R D C R E AT I O N

You may choose between different aspects of your environment’s monitoring to
display them on screen. You may choose, for example, the list of the last events
generated.
This will get your widget ready, which you have to configure to define the desired
pandorafms.com

parameters, such as the type of events you want it to display, the list size, severity
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or the group they belong to.

Once selected, your widget will start showing the data and you may start adding
as many as you want by clicking “Add cell (+)” in the edit view.

DA S H B OA R D C R E AT I O N
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Following this process, you can build a dashboard like this with a few clicks:
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Events

An event is everything that happens within the system. It may be module creation
or even user login in the console. The event itself is a descriptive text of the
problem, its source, an agent, and its creation date.
Pandora FMS allows displaying in real time all the events of your monitored
systems. With this information, you may carry out the necessary actions according
to the created event. Information is shown about any module status changes,
launched or recovered alerts, system restarts or custom events.
Depending on the information he event has, it will appear in one color or another.
For example, if an information event says a module has gone into a critical status,
this event will appear in red.
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Thanks to this default view you may see the active “problems” in real time.
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Going into critical or warning events are automatically validated when the situation
returns to normal. This is what is known in Pandora FMS as event auto-validation
and it is an essential feature, since it allows to hide the information that is no longer
relevant in the event console.
There is the possibility in Pandora FMS of setting alerts on events, so instead
of acting on each module, it could be done on a specific group of modules,
generalizing monitoring and making alert deployment much easier.
Correlation and event alerts are an Enterprise feature.
Besides, correlation rules can be created on the events, creating true logical
heuristics when dealing with events. Obviously, these are advanced and complex
features that are not seen in this quick guide.
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Working with Policies in Pandora FMS
Pandora FMS offers the possibility of working with previously seen alert and
module creation and management tools in more efficient ways. One of them is the
mass operations tool.
However, the most powerful of these tools are monitoring policies.
Policies are groups of settings where you add elements that you may later mass
load in the agents or agent groups. Those elements can be monitoring modules
(remote or local), alerts and script collections for local monitoring.
Policies are an advanced Enterprise version feature.
Policies are designed to make monitoring’s initial deployment easier and also to
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homogenize monitoring management, since you may unify checks by different
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criteria such as Operating System, applications, network... that is, by any common
factor of the software and remote agents previously installed or included.
If you go to Configuration -> Manage policies, you will see some already created
by default, and others created especially for the monitoring you implemented
specifically according to the applications to be used.

If you take a look at the policies located at the top, you find those for operating
systems such as Windows, Linux or Solaris.
For example, with the basic Linux policy, if you go to module section, you see some
already preloaded to obtain the corresponding checks on CPU usage, available
memory and other metrics. These modules can be both local and remote:

WO R K I N G W I T H P O L I C I E S I N PA N D O R A F M S

Right next to it there is another menu with options like a Wizard to create both
interface and WMI modules. You will be able to create inventory modules, link
policies and modules, use agent plugins to monitor applications, use collections to
upload files between Pandora FMS server and the software agent or create both
internal and external alerts.
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Once a policy is defined, it will be assigned to new agents:
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Apply the policy to the agents assigned to that policy. That way you will
“synchronize” the configuration of all agents and you will make sure monitoring
settings are the same for all policy agents.

WO R K I N G W I T H P O L I C I E S I N PA N D O R A F M S

Once done, all selected agents will have in their configuration the modules this
policy comes with as well as alerts, plugins and collections in a massive, simple
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and fast way.
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Next Steps

This guide does not cover them but you may be interested:

Collecting Logs with Pandora FMS.
Network Maps.
Monitoring with SNMP Traps.
Log Collection and Monitoring.
WEB User Experience (WUX) Monitoring.
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Managed system remote access (Quick Shell).
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IT Automation (Omnishell).
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Where to Look if Problems Arise?
In the face of any problem, Pandora FMS offers different tools to take measures:

•

Diagnostic tool: in Admin tools -> Diagnostic info, it will provide you with a list
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of essential system information.
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•

Event viewer: In Events -> View events, it displays all the events generated in
your environment and allows working with them in a simple way.

•

Audit viewer: In Admin Tools -> System audit log, it shows monitoring
environment detailed information.

WHERE TO LOOK IF PROBLEMS ARISE?

Advanced information sources
Information sources (logs) where you may look for more information, errors, etc:

•

“/var/log/pandora/pandora_server.log’’. Server log file that contains very
important clues. If you want more details, modify the ‘’verbosity’’ parameter
of the server configuration file to show more details.

•

‘’/var/log/pandora/pandora_server.error’’. Log file of not captured server
errors. It contains traces of errors not handled by the server, they are usually
bad stuff.

•
•

“/var/log/pandora/pandora_agent.log’’. Unix agent log file.
‘’%PROGRAM_FILES%\pandora_agent\pandora_agent.log’’. Windows agent
log file.

•

‘’/var/www/html/pandora_console/log/console.log’’, Pandora FMS console
log file.
“/var/log/httpd/error_log’’, Apache server error log file (httpd).
“/var/log/messages’’, system log file.
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•
•
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Support

Pandora FMS Forum

The forum is open 24x7 to anyone, you may create an account and ask questions.
It is totally for free and there are communities in English and Spanish. It has more
than 15,000 messages that can be used to find the solution to a problem like yours
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or to ask our community.
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FAQ de Pandora FMS

We have a list of frequently asked questions (FAQ) that can give you a hint or
directly a solution to a particular problem.
Pandora FMS official training

Of course, you also have the option of training, through Pandora FMS official
courses (certified). More information in our website.

